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Format of the mailing list

On this diskette, the Ner Tamid newsletter mailing list is kept on a Works database.  The database has
about 20 fields.  The ones pertinent to newsletter mailing are listed in Table 1.

Field Title Contents
Code Membership code: 1=member, 2=employee, 40=prospect, 41=courtesy
Title MR AND MRS, etc.  All punctuation is omitted
First First name (surname)
Spouse

Spouse’s name - if none, an empty text string (a single " in Works) is entered
Last Last name (family name)
FirmName Company name, such as Jewish Community Center, if needed
DeliveryAddress Street address or postal box in USPS standardized format (see below)
City City (USPS standardized)
State Two letter official USPS abbreviation
Presort A spare column available for sorting codes
PostalCode USPS ZIP+4 postal code in the form 75010-4138
CRRte Carrier route code (unused)
DPC Two-digit USPS Delivery point code (From RIBBS or the Web site - typically the 

last two digits of the street address)
ChkDig Barcode check digit which when added to the sum of the digits in the ZIP+4 and 

DPC results in a multiple of 10
AADC

3 digit Automated Area Distribution Center from labeling list L801 (see below)
BarCodeString DPC barcode string in the form /zzzzz4444ddc: which, when typeset in 16 point 

USPS Bar Codes TrueType font, looks like

Table 1. Mailing list column headings

Adding to the mailing list

To add a new name/address to the list, use the following procedure:

 1.  Standardize and complete the address using one of the USPS zip code servers listed in Table 2. The
result will be in all capital letters and will provide values to be subsequently entered into the database
fields DeliveryAddress, City , State, PostalCode, CRRte, DPC, and CheckDig.  These must be
preceded by an initial" (double-quote character) to signify that they are treated as text, rather than
numeric values.  No space should be placed between the " and the rest of the field.



2. From the Works File menu, select Open Existing File… and select NTAMILIS.WDB to bring the
mailing list into view. Scroll to the place you want to insert the new record, and select the
Record/Field option from the Insert menu.  Once the blank record has been created, fill i n the new
name/address information.

3. Enter an empty string (a double quote character in Works) for entries without a spouse.
4. In the Notescolumns, I usually include a date telling when the entry was added to the mailing list so

that stale entries may be deleted.
5. The BarCodeString entry is constructed from the PostalCode, DPC and CheckDig entries by

placing the digits from these fields (skipping the hyphen in the ZIP+4) bracketed between an initial
"/" and a final ":" and formatting the result in 16 pt USPS Bar Code font.  This font is on this
diskette.  This field can be constructed automatically by copying the =REPLACE(...) formula from
an adjacent record.  If the resulting barcode is empty or looks odd, you've probably forgotten a
leading " in the DPC and/or CheckDig field.

6. Finally, the AADC column should be filled in.  This is a 3 digit number based upon the first 3 digits
of the ZIP code for the address.  For 750 and 752, the AADC and the 3-digit ZIP prefix are the same.
For other area ZIP codes, look on the mailing for another ZIP beginning with the same 3 digits and
copy the corresponding AADC entry.  In the rare event that you don’t fi nd one already on the list,
you can use the AADC calculator in file L801.WKS on this diskette.  Note that neither the AADC
nor the CRRte fields are part of the BarCodeString.

Server Connection Information
RIBBS Bulletin Board telnet://ribbs.usps.gov

Select ZIP+4 Demo from the main menu
USPS Web site http://www.usps.gov/ncsc/lookups/lookup_zip+4.html

Envelope Manager Jr. Download from RIBBS File Area 2 (Computer Utils)
Current list of station dialup numbers can be retrieved from 
ftp://ftp.envmgr.com/STATIONS.DAT

Table 2. USPS address standardization services

Service Telephone No.
Carrollton Main Post Office (972) 418-7858
Postal Business Center (972) 393-6701

Table 3. Postal Information Numbers

Presorting the mailing list

An important part of newsletter mail preparation is address presorting.  Obtaining the special discounted
mailing rates of less than 10¢ a letter that Ner Tamid enjoys requires presorting the mailpieces according
to specific rules spelled out in the Domestic Mail Manual, available for public inspection at all US Post
Offices during normal business hours.  For Ner Tamid, the rules boil down to insuring, by duplicating
addresses if necessary, that we are mailing at least 200 newsletters at a time and that we have prepared
them in two batches of mail—an origin ZIP tray and a mixed AADC tray.  (A tray is a special two-foot
long container and sleeve which can be picked up free of charge from the Carrollton post office.  Ask in
back at the business mail entry counter for EMM trays and sleeves.)



The origin ZIP tray is very simple to prepare.  It consists of all mail with addresses whose ZIP code
begins with the three digits 750.  Within this origin tray, mail should be sorted in increasing ZIP code
order.

The mixed AADC tray take more work to prepare.  All addresses with ZIP codes not beginning with 750
should now be separated and sorted according to increasing AADC number.

Using the mailing list database, these presorts can be accomplished in several ways.  I recommend the
following procedure (in List view):

1. Select the column below the Presort titl e and, using the Fill Down option on the Edit menu, fill it
with a large number, e.g. 9999.

2. Sort the mailing list by increasing PostalCode(i.e. ZIP code).
3. Find the block of entries beginning with PostalCode 750 and fill in the value 1 in the corresponding

Presort column block.
4. Sort the mailing list by increasing Presort value and increasing AADC as the secondary sort key.

This completes the presort.

Preparing the newsletter labels

Once the  mailing list is properly presorted, peel-off mailing labels should be prepared.  We use 1"x4"
white labels (Avery 5161 or equivalent).  These labels come 20 per sheet.  The Works word processor is
capable of formatting and printing them directly from the mailing list database.  The file
NTAMILIS.WPD on the diskette is preformatted.  The format of each label is as follows:

BARCODE
TITLE  FIRSTNAME  LASTNAME (if not blank)
FIRMNAME (if not blank)
DELIVERYADDRESS
CITY  STATE  POSTALCODE

Note that there are no punctuation marks except for the hyphen in the ZIP+4 postal code.  A sans-serif
font such as 9 pt Arial or Helveticais used for the label text, except for the barcode.  The delivery point
barcode is inserted in 16 pt USPS Bar Code font from the BarCodeString field of the mailing list.

To print the labels from Works, click the cursor anywhere within the label area at the top of the
document.  Then use the File menu to Print the labels.  You will be prompted to select the mailing list
database file as input.  If you use the Print Preview option, be aware that the barcodes may only appear
after zooming the view.

When first formatting the mailing label document template, you should try printing a sheet on plain paper
to check that your printer properly aligns the text on the labels.  There should be at least an eighth of an
inch of white border on the label.  If not, play around with margins, row and column widths, etc. until the
result fits the label area properly.

Newsletter folding and labeling



Once the labels have been prepared and the newsletter printed and delivered to the Goodman’s, they must
be collated, folded, taped and labeled.  It helps to have extra hands at this stage, hence the monthly
newsletter folding party.  Newsletter folding and labeling supplies (tape, label guides and rubber bands)
are kept in a box on top of the cabinets in the kitchen area.

When the printer prints the newsletter, multiple copies (about 250) of each sheet are run off together.
Collating is the process of combining these separate stacks into finished newsletters. Place each pile of
sheets face down in order so that the visible left hand page numbers of the piles read 2, 4, 6, … . Take
one at a time from each stack and put them together.

Once a newsletter has been collated, it needs to be folded twice.  The first fold is down the center of the
sheet, making it into an 8½" by 11" booklet.  The second fold is horizontal, folding the front page of the
newsletter in on itself, leaving the return address and permit imprint visible.  Do not worry about folding
exactly along the horizontal separator line on the back; simple make the folded newsletters neat.

After the second fold, the Post Office requires the newsletters to be tabbed to prevent them from opening
freely.  A piece of transparent tape applied to the 8½" side works just fine to hold the folded newsletters
closed.

The last step before postal sorting and traying, is applying the labels.  This must be done carefully,
respecting the following rules:

1. Each label must be parallel to the bottom of the mailpiece, i.e. the second newsletter fold.
2. There should be at least 5/8" clearance between the label and the bottom of the mailpiece.
3. The maximum allowable tilt away from parallel is 5º skew.
4. Hand corrections to the label text are not permitted.

I find that the large plastic tabs used to label hanging file folders work quite well as guides.   Or prepare a
carefully precut, folded piece of heavy paper.  In either case, insert the bottom edge of the mailpiece
flush against the bottom of the guide and apply the label against the top edge of the guide.

Sorting and traying the newsletter

Assuming you have presorted and printed the mailing labels before applying them, the newsletters should
now be in correct order for traying.  Place the 750 group into one tray and all the rest into the other
(mixed AADC) tray.  Properly barcoded labels for these trays are either already printed by myself or
generated from a small Excel spreadsheet workbook I prepared.  They can also be ordered free of charge
(albeit in minimum quantities of 300 at a time) from the Post Office through the Postal Business Center.
The compressed archive LABSHEET.ZIP on the diskette contains a Works word processing document
LABSHEET.WPS which you can print to produce two labels. After printing, cut them out carefully and
glue to a heavy white paper backing.  I find the address change forms that the Post Office mails us when
someone has moved work well as a backing.  Place a 750 label in the label holder at the end of one tray
and the 760 label on the other tray.

In the likely event the trays are not full, or not at least 3/4 full, the newsletters will need packagingto
prevent them from getting jumbled up in transit.  Packaging consists, in this case, of bundling groups of
newsletters up to 6" thick together with elastic rubber bands.  When the package is more than 1" thick,
two bands are used.  The first goes around the mailpieces the long way (parallel to the bottom edge) and



the second around the short way (perpendicular to the bottom edge).  Omit the first elastic band if the
package is less than 1" thick.  Making packages consist of multiples of 10 newsletters helps to make
counting easier.

After the mailpieces are fully trayed, place them within their cardboard sleeves.  Be careful not to crimp
or crush the newsletters during this process.  Once sleeved, the trays must be secured with a plastic strap.
The strapping kit is a white box in the kitchen closet on the top of one of the back shelves.  Instructions
for its use are imprinted on the side of the kit.  The strap should go around the tray lengthwise,
depressing, but not crushing, the ends of the sleeves. The plastic buckle should be approximately
centered on the top of the tray and the trailing ends of the strap trimmed close to the buckle.

Bringing the mail to the Post Office

Bulk mailings are submitted at the Bulk Mail Office, which is entered around back of the main Carrollton
Post Office on Jackson Road, across from the police station.  Each bulk mailing must be accompanied by
two pieces of paper:

1. the postage statement Form 3602-N, and
2. a copy of a current Form 3553 CASS address certification.

Blank postage statements are available from the Carrollton Post Office or may be downloaded from the
RIBBS bulletin board or USPS web site for printing with Adobe Acrobat.  With a JAVA-capable
browser,  you can even fill one out electronically from the USPS web site and print it on your local
printer.  A similar facility is available in the form of a Microsoft Word template I devised, which is
available on the Internet via my web page http://sepwww.stanford.edu/oldsep/stewat Stanford
University.  Whichever way you do it, the key information you need to supply are:

Post Office of Mailing Carrollton TX 75006
Permit No. 163
Mailing Date Date you bring trays to the Post Office
Permit Holder Congregation Ner Tamid

PO Box 112772
Carrollton TX 75011-2772

Telephone (972) 416-9738
Processing Category Letters (DMM C050)
Prepared Under DMM M810 (Automation letters)
Number of Containers 2-Ft EMM Trays: 2    Total Ltr. Trays: 2
Authorized nonprofit rates? Yes
Mailing Agent Your name and address
Total pieces The number of newsletter mailed
Postage Part A Basic Letter computation from back of form
Total Postage Same as Part A total
Mailing Agent Signature Your signature

The CASS certificate can either be photocopied or printed directly from a text file supplied by the CASS
certifier.  CASS0597.WPS on this diskette contains a duplicate you can print from Works.  You will need
to fill in your name and address and sign the form in the areas provided.



Once you have the paperwork ready, the clerk at the bulk mail acceptance counter will check and weigh
the mailing and take your money.  It’s a good idea to prepare the postage statement in duplicate so that
you can use one for a receipt.  However, the clerk will normally cheerfully prepare a separate receipt if
you request it.

That’s it!  Job well done!


